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POVZETEK 

Adobe After Effects je program namenjen izdelavi animacije. Natančneje opredeljeno se 

program uporablja predvsem za izdelavo gibljivih grafik in vizualnih efektov. 

V diplomski nalogi je zajet proces izdelave grafične animacije za animirani poslovni 

portfolijo Mitje Lundra. V prvem delu zajema opis nastajanja koncepta in razvoj ideje. Nato 

so predstavljene osnove in funkcije uporabniškega vmesnika. Sledeča poglavja so namenjena 

opisu procesa izdelave v programu After Effects. To delo zajema izključno orodja, ki so bila 

potrebna za izdelavo animacije, in bralcu postopoma podaja informacije o poteku nastajanja 

končnega izdelka.  

Celoten projekt je produkt inspiracije različnih animiranih portfolijev ter lastnega veselja do 

animacije in učenja programa Adobe After Effects.   

Ključne besede: Adobe After Effects, animacija, video, izdelava, promocija, projekt



 

 

SUMMARY 

 

PRODUCTION OF ANIMATED VIDEO LIMEDIVINE.COM 

SHOWEEEL 2013 IN ADOBE AFTER EFFECTS 

 

Adobe After Effects is a program intended for the production of animation. More precisely, 

the program is mainly used for creating motion graphic and special effects.  

 

The thesis covers the process of making a graphic animation for a business portfolio of Mitja 

Lunder. The first part is focused on the development of the idea. The second part explains the 

fundamental parts and functions of the user interface. And the third part explains the process 

of creating the final product, step by step. This thesis is focused on one particular animation 

and it only covers the necessary tools for creating it.  

 

The entire project is a product of inspiration of various other animated portfolios, as well as 

my own interest in learning animation techniques and mastering the Adobe After Effects.  

 

Key words: Adobe After Effects, animation, video, production, promotion, project 
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1   UVOD 

1.1 Opredelitev področja 

Program Adobe After Effects je močno programsko orodje iz serije programov Adobe. 

Omogoča vstavljanje različnih efektov in obdelavo videa, prav tako pa se ga uporablja v 

namene animiranja  grafik in tekstov. Pokrivanje vseh področji programa bi bilo preobsežno, 

zato sem se odločil, da se osredotočim na področje animiranih grafik in tipografije, ki jih bom 

obravnaval skozi nastajanje lastnega animiranega videa.  

 

1.2 Namen 

Namen je raziskati eno od področji animacije, ki ga zajema program After Effects, in skozi 

izdelavo lastne produkcije raziskati orodja, ki nam omogočajo izdelavo animacije. Animacijo 

želim izdelati s čim manj ali brez pomoči virov izven programa. Ker gre za promocijski video, 

sem v animaciji želel izpostaviti predvsem področje dela mojega naročnika in predstaviti 

nekaj njegovih izdelkov ter s tem privabiti nove stranke za njegovo podjetje. Moj naročnik je 

poklicni oblikovalec, zato je namen izdelati grafično dovršeno animacijo, ki izpostavlja 

njegove kompetence in informira gledalca o njegovem delu, hkrati pa je tudi dovolj zanimiva, 

da si gledalec video ogleda do konca. 

 

1.3 Predpostavka 

Večinoma si pod imenom After Effects predstavljamo efekte, ki dopolnjujejo neki video 

posnetek, pa naj si gre to za spektakularne filmske efekte; kot so razne eksplozije, animirana 

ozadja, portali, teleporti in podobno; ali pa za različne reklame oglase, ki so podkrepljeni z 

animacijo. Za tovrstno delo je potreben film, moja predpostavka temelji ravno na tem, da za 

končni produkt ne potrebujemo nobene filmske ekipe ali video posnetkov, s katerimi bi 

manipulirali, saj lahko samo z orodji, ki nam jih ponuja program, naredimo animirani video, 

ki lahko stoji sam zase.  
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1.4 Metoda raziskovanja 

Moja glavna metoda raziskovanja bo program sam, kjer bom spoznaval orodja in ugotavljal, 

kaj mi le ta omogočajo. Pri tem si bom pomagal s priročniki, ki obravnavajo področje grafične 

animacije, velik del informacij pa nameravam črpati iz internetnih člankov in video vodičev, 

saj je večina literature na to temo pri nas težje dostopna. 
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2 RAZVOJ IDEJE 

 

Ideja za izdelavo videa Limedivine.com Showreel 2013 se je prvič porodila, ko sem prijatelju, 

ki je poklicni oblikovalec, omenil, da se ukvarjam z izdelavo video produkcije v Adobe After 

Effects. Prosil me je, če bi mu lahko naredil promocijski video za njegove izdelke in spletno 

stran. Ideja se mi je zdela zanimiva, poleg tega pa se mi je zdelo, da lahko video uporabim kot 

lastno referenco za bodoče potencialne stranke. 

 

2.1 Koncept 

Pred začetkom razvijanja koncepta sem si ogledal nekaj primerov tovrstnih promocijskih 

videov in  skušal ugotoviti, kakšen tip animacije želim ustvariti in kakšen vtis želim, da bi 

animacija ustvarila na gledalca. Razvilo se je kar nekaj idej, za katere sem naredil nekaj 

osnovnih animacij, vendar nobena ni ravno odražala občutka, kakršnega sem si želel. Zato 

sem iskal dalje in naletel na amaterski oglas za MTV (http://youtu.be/bzW4jTiE6Ao), čigar 

stil se mi je zdel najbližje temu, kar bi želel pri animaciji.  

 

Tovrstne promocijske animacije so na nek način zelo podobne Power Point prezentacijam, ki 

so sestavljene iz različnih prosojnic, z razliko, da nam Adobe After Effects omogoča 

ustvarjati bolj dinamično predstavitev in naredi celotno zadevo bolj zanimivo za gledalca. 

Zato je bil prvi korak razdeliti animacijo na prosojnice, opredeliti, kaj bodo zajemale, ter 

določiti časovno zaporedje le teh. Zelo pomembna komponenta pri tovrstnih animacijah je 

tudi dinamika, saj sem skozi opazovanje ostalih projektov ugotovil, da jih večina, ki so daljši 

od ene minute, postane nezanimivih, zato sem se odločil, da animacijo omejim na približno 

eno minuto. S tem pa sem tudi omejil število prosojnic in njihovo trajanje. Posledično je bilo 

potrebno okvirno preračunati, kakšno bo število prosojnic ter koliko časa bo trajal prikaz 

posamezne prosojnice. Pri tem pa je bilo potrebno biti pozoren še na čas prehodov med 

posameznimi prosojnicami. Pri organizaciji časovnice je potrebno biti zelo dosleden, zato je 

že na začetku dobro čim bolj natančno določiti čas animacije, saj šteje vsaka sekunda, kajti 

nekaj odvečnih sekund lahko hitro spremeni dinamiko celotne animacije in jo naredi 

http://youtu.be/bzW4jTiE6Ao
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dolgočasno. Prav tako pa je pomembno, da prosojnice niso prekratke, saj lahko tako gledalec 

ne zazna kakšnega elementa ali informacije.  

Glede na podobne animacije, ki sem si jih ogledal, sem se odločil za sledeče zaporedje 

prosojnic: 

Uvodna prosojnica (4s – 5s) 

Pojasni, da gre za promocijski portfolio in čigav. 

Področja dela, s katerimi se ukvarja (4s – 5s) 

Navede področja dela, s katerimi se promotor ukvarja. 

Programi, ki jih uporablja za svoje delo (4s – 5s) 

Navede programe, s katerimi promotor zna upravljati in jih uporablja za svoje delo. 

Nagovor k pregledu njegovega dela (4s – 5s) 

Nagovori gledalca, da si ogleda nekaj izdelkov iz njegove zbirke. 

Galerija (7 slik) (24s) 

Slike izdelkov. 

Nagovor k obisku spletne strani (4s – 5s) 

Nagovori gledalca k obisku spletne strani, kjer si lahko ogleda še ostale projekte. 

Kontakt (9s – 10s) 

Povezava do spletne strani.  

 

Takšno je predvideno zaporedje prosojnic, njihova vsebina in trajanje. Seštevek trajanja vseh 

prosojnic nanese ravno nekaj sekund pod minuto, kar je ravno prav, če temu dodamo še nekaj 

sekund za prehode med posameznimi prosojnicami. 
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2.2 Priprava grafik 

Po izdelavi okvirnega koncepta celotne animacije sledi izdelava grafične podobe ter grafičnih 

elementov. Ker je prijatelj, ki me je prosil za izdelavo animacije, med drugim tudi grafični 

oblikovalec, se je odločil, da večino grafične podobe izdela sam, saj je najbolj vedel, kakšen 

videz si želi. Pridobil sem grafike v programu Adobe Illustrator, ker sem predvideval, da je 

vektorske elemente mogoče izvoziti in jih vstaviti v Adobe After Effects. Žal se je izkazalo, 

da to ni izvedljivo, zato sem moral vsak element posebej shraniti kot sliko in jih nato 

lastnoročno vstaviti v After Effects.  

 

Slika 1: Adobe Illustrator 

Vir: Lasten 

Vsaka prosojnica je vsebovala med 7 do 11 elementov, poleg tekstov, ki sem jih naredil v 

After Effects, ker mi je to omogočalo boljše opravljanje s teksti. Za vsako prosojnico sem 

naredil posebno datoteko, kamor sem shranil vsak element posebej, na prosojnem ozadju.  

 

Namen projekta je bil narediti animacijo, s čim manj ali brez pomoči ostalih programov. Vse 

grafike narejene v programu Illustrator bi bilo mogoče izdelati tudi v After Effects, vendar bi 

to vzelo bistveno več časa, saj orodja v After Effects niso usmerjena v izdelavo grafik. 

Izvažanje in sortiranje iz programa Illustrator je trajalo nekaj ur, če bi grafike želel izdelati v 

After Effects, bi mi to lahko vzelo tudi po več dni. Ker pa je čas ključnega pomena pri delu s 

strankami, sem se odločil za pomoč z orodji izven programa Adobe After Effects. 
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3 UPORABNIŠKI VMESNIK PROGRAMA 

 

Za lažje razumevanje dela bom na kratko predstavil osnovne temelje uporabniškega 

vmesnika. Povzel bom glavna delovna okna, njihov namen in osnovna orodja. 

 

3.1 Delovna okna 

 

Slika 2: Delovna okna 

Vir: Lasten 

• Pod številko ena je označena orodna vrstica. Za razliko od sorodnih programov, ki 

imajo orodno vrstico ob strani, kot na primer Photoshop in Illustrator, se v After 

Effects ta nahaja na vrhu. 

• Pod številko dve se nahaja projektno okno. V tem oknu lahko vidimo vse uvožene 

elemente in kompozicije, ki se nahajajo v našem projektu.  
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• Številka tri označuje časovnico. Na levi strani imamo seznam elementov, ki smo jih 

postavili na časovnico, na desni pa časovni trak, ki nam kaže dolžino trajanja. 

• Številka štiri označuje kompozicijsko okno. Vsi na časovnico vstavljeni elementi se 

pojavijo v kompozicijskem oknu, ki nam omogoča pregled našega dela. 

• Pod številko pet je označena vrstica za predogled animacije.  

• Številka šest označuje okno, kjer se nahajajo efekti, ki jih lahko vstavljamo v projekt. 

 

Tu so prikazana samo najbolj nujna okna, ki so potrebna za delo v programu. Vsako okno se 

potem deli še na dodatne zavihke, ki nam omogočajo še druge možnosti za delo.  

 

3.2 Orodja 

 

Slika 3: Orodja 

Vir: Lasten 

Na zgornji sliki so navedena orodja iz orodne vrstice. Črke v oklepajih označujejo bližnjice za 

hitrejši dostop do orodja. Za začetek so najpomembnejša naslednja orodja: 

 

Selection Tool: Orodje, s katerim lahko primemo elemente in jih premikamo po kompoziciji. 

Hand Tool: S tem orodjem primemo celotno kompozicijo in jo pomikamo po X/Y osi. 

Zoom Tool: To je orodje za približevanje in oddaljevanje kompozicije. 

Rotation Tool: To orodje nam omogoča obračanje elementov. 
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Mask/Shape Tools: Orodje, s katerim lahko ustvarjamo like ali maske različnih 

geometrijskih oblik. 

Pen Tool: Orodje za risanje mask ali poti (path).  

Type Tool: Orodje za ustvarjanje teksta. 

To so orodja, s katerimi bom delal največ in so najbolj osnovna. Ostalih orodji nisem omenjal, 

ker jih ne bom potreboval ali pa bom njihovo funkcijo razložil kasneje na primeru.  
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4 KOMPOZICIJA 

 

4.1 Nova kompozicija 

»Kompozicija v programu After Effects je kamor vstaviš svoj delovni material. Je kot 

virtualno platno, kamor postaviš in urejaš svoje elemente in jih usmerjaš skozi čas.« (Meyer, 

2010, str. 14) 

 

Za novo kompozicijo je potrebno odpreti zavihek Composition > New Composition (Ctrl+N). 

Pri tem se nam odpre novo okno z nastavitvami kompozicije. 

 

Slika 4: Nastavitve kompozicije 

Vir: Lasten 
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En projekt lahko vsebuje več kompozicij, zato je najprej potrebno poimenovati kompozicijo, 

ker se bomo tako kasneje lažje organizirali pri delu. Ime vpišemo pri oknu, kjer piše 

Composition Name. 

Nato pod zavihkom Presets nastavimo format videa, s katerim želimo delati. Ker animacija ne 

bo vsebovala nobenih video posnetkov in ker je njen namen predvsem spletna promocija, sem 

se odločil za format HDTV 1080 24. To pomeni, da bo naš video visoke kakovosti (High 

Definition) in bo vseboval 1080 slikovnih točk v višini. Razmerje med višino in širino slike 

bo 16:9, kar pomeni širokozaslonsko razmerje, animacija pa se bo predvajala s 24 sličicami na 

sekundo (24 fps). 

 

Pod zavihkom za resolucijo (Resolution) nastavimo kvaliteto slike, ki nam jo program 

predvaja v predogledu. Višja resolucija pomeni, da bo slika boljša, vendar bo čas nalaganja 

animacije daljši; nižja resolucija pa nam bo skrajšala čas nalaganja in s tem popačila kvaliteto 

slike. Nato je potrebno nastaviti še dolžino kompozicije. Ker sem predvidel, da bo moja 

animacija dolga okrog ene minute, sem nastavil čas trajanja na 1min.  

 

Kot zadnjo nastavitev lahko nastavimo tudi barvo ozadja. Ta v mojem primeru ni pomembna, 

saj bom ozadje prekril s sliko. 

 

Če nam katera od izbranih nastavitev ne ustreza, jo lahko tudi kasneje spremenimo.  

 

4.2 Vstavljanje elementov 

Ko imamo ustvarjeno novo kompozicijo, vanjo začnemo uvažati elemente, s katerimi 

nameravamo upravljati. To lahko naredimo na več načinov. En način je, da odpremo v meniju 

File > Import > File. Lahko uporabimo bližnjico Ctrl+I ali pa v projektnem oknu (glej Slika 2, 

točka 2) izberemo zavihek Project in dvakrat kliknemo v prazno okno, kjer imamo 

kompozicijo. To bo odprlo novo okno, ki omogoča iskanje datotek, katere želimo uvoziti. 

Izberemo lahko eno ali več datotek hkrati in nato pritisnemo Open. 
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Okno nam omogoča še določene možnosti za uvažanje specifičnih datotek, ker tega nisem 

potreboval, sem pustil privzete nastavitve.  

 

4.2.1  Organizacija elementov 

Moj projekt vsebuje veliko elementov in skoraj vsak element bo vseboval kakšen spremenljivi 

parameter, zato je zelo pomembno, da je celoten projekt dobro organiziran. Več elementov 

pomeni tudi večji napor za računalnik, zato sem se odločil, da za vsako prosojnico naredim 

svojo datoteko in jo izvozim kot video, nato pa ustvarim končno datoteko, kjer bom animiral 

samo prehode med videi. Tako bom imel boljši pregled nad celotnim projektom in računalnik 

bo delal bolj tekoče. Druga opcija pa bi bila narediti več kompozicij v eni datoteki. 

 

V prejšnjem podpoglavju sem opisal, kako datoteke uvoziti v program. V primeru, da je le teh 

veliko, je smiselno znotraj programa ustvariti mape za boljšo preglednost celotnega projekta. 

To bi bil primoran narediti v primeru, če bi celoten projekt delal v eni datoteki. 

 

4.2.2  Vstavljanje elementov na časovnico 

Kljub temu, da so datoteke z elementi že uvožene v program, je naše kompozicijsko okno 

(glej Slika 2, točka 4) še vedno prazno, ker je elemente potrebno vstaviti na časovnico (glej 

Slika 2, točka 3).  

 

To naredimo tako, da označimo elemente, s katerimi želimo upravljati, in jih postavimo na 

časovnico. Ko to naredimo, se nam na desni strani pokažejo trakovi, ki označujejo čas 

trajanja. Pri statičnih datotekah, kot so slike, je čas trajanja dolg toliko, kolikor je dolga naša 

kompozicija. V mojem primeru je čas trajanja vsake slike 1 minuta. Kasneje, ko bom izvozil  

animacijo vsake prosojnice kot video, pa bom na časovnico vstavljal video. V tem primeru je 

trak, ki označuje čas trajanja, dolg toliko, kolikor je dolga dolžina videa, ki ga vstavimo. 
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4.2.3  Prioritete plasti 

Vsak element na časovnici predstavlja svojo plast (Layer). Zaporedje plasti pa je zelo 

pomembno, saj določa zaporedje, kako se bodo elementi prikazovali v kompozicijskem oknu. 

Plasti na vrhu seznama bodo prekrivale plasti, ki so nižje na seznamu.  

 

Slika 5: Plasti 

Vir: Lasten 

Kot je razvidno iz slike zgoraj, se vse plasti s teksti nahajajo na vrhu seznama. V primeru, da 

bi te tekste prestavil nižje, jih ne bi bilo mogoče videti, ker bi prioriteto dobil neki element iz 

ozadja in bi prekril tekst. V mojem primeru je to zelo pomemben faktor, saj kompozicija ni 

sestavljena iz ene slike, ampak je vsaka slika svoj element, zato je zelo pomembno, da je 

zaporedje plasti pravilno postavljeno. 

 

Različne plasti imajo različne ikone, glede na to kaj ta plast predstavlja. Na primer: če gre za 

tekstovno plast, je zraven imena plasti ikona v obliki črke T; če gre za geometrijsko telo, je 

ikona v obliki zvezde ... 
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4.3 Postavitev elementov 

Ko so elementi vstavljeni na časovnico, so vsi postavljeni v center kompozicije, zato jih je 

potrebno ročno prestaviti na mesto, na katerem bi želeli, da se nahajajo. Jaz sem za referenco 

imel kompozicijo iz programa Illustrator. Glede na videno sem svoje elemente postavil tako, 

da so tvorili takšno kompozicijo, kakršna je bila v programu Illustrator.  

 

4.4 Kompozicija v kompoziciji 

Program omogoča tudi, da naredimo kompozicijo znotraj kompozicije. Če zadevo 

poenostavim, bi temu lahko rekli mapa na časovnici. Kot sem že omenil, lahko v projektnem 

oknu ustvarimo mapo in si tako uredimo uvožene elemente. Podobno je pri kompoziciji v 

kompoziciji. Vendar pa zraven organizacije ta metoda služi tudi za lažjo animacijo.  

 

Kompozicijo znotraj kompozicije naredimo tako, da izberemo plasti, ki jih želimo v novi 

kompoziciji in izberemo v meniju Layer > Pre-compose ali pa uporabimo bližnjico 

Ctrl+Shift+C. Tako se nam na časovnici pojavi nova plast z ikono filmskega traku, v kateri se 

nahajajo vse plasti, ki smo jih pred tem izbrali. Tako kot pri ostalih plasteh je tudi pri tej 

pomembno zaporedje na seznamu plasti.  

 

To metodo sem uporabljal predvsem iz dveh razlogov. Prvi je zaradi boljše preglednosti in 

organizacije, drugi ker mi omogoča, da v kompoziciji znotraj kompozicije vidim in animiram 

samo določene elemente. To pa je uporabno, kajti ko hočem videti predogled animacije, lahko 

vidim samo elemente, ki so znotraj te kompozicije. Posledično računalnik hitreje naloži 

predogled, ker mu ni potrebno nalagati še ostalih elementov, ki me v določenem trenutku ne 

zanimajo.  

 

Ta metoda nam omogoča še veliko drugih trikov, vendar jih v tem primeru nisem uporabljal, 

zato jih ne bom podrobneje omenjal. 
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4.5 3D prostor 

After effects ima tudi funkcijo, ki omogoča gibanje in rotacijo elementov v 3D prostoru. Gre 

za funkcijo, ki nam omogoča veliko novih možnosti za animacijo. V svojem projektu sem 

uporabil le delček potenciala, ki ga omogoča 3D prostor v programu. Glavna funkcija v 

mojem primeru je bila uporaba kamere in sledenje kameri. Če želimo uporabljati virtualno 

kamero, morajo biti plasti v kompoziciji nastavljene kot 3D plasti (več o kameri v poglavju 

Kamera).  

 

3D plast naredimo tako, da kliknemo na prazen kvadratek na plasti, ki jo želimo spremeniti v 

3D. 

 

Slika 6: 3D plasti 

Vir: Lasten 



23 

 

5 ANIMACIJA 

 

5.1 Osnove animacije 

»Animacija je proces ustvarjanja gibljivih grafik in spreminjanja oblik.« 

(http://en.wikipedia.org/wiki/Animation) V tem poglavju bom predstavil temeljne značilnosti 

in orodja za animacijo, ki sem jih uporabil za izdelavo svoje animacije. 

 

5.1.1  Key Frame / Ključni okvir 

Pojem, ki se pri digitalni animaciji največ uporablja, se imenuje »Key Frame«. »Key Frame« 

v animaciji »… definira začetno in končno pozicijo določenega objekta.«
 

(http://en.wikipedia.org/wiki/Key_frame). 

Na spodnji sliki je prikazan del časovnice, točki na označenem delu predstavljata »key 

frame«; prva točka na traku predstavlja začetek animacije, druga pa zaključek. Za animacijo 

določenega objekta moramo določiti, kdaj se bo animacija začela, katero nastavitev želimo 

animirati in kakšni bodo začetni parametri. V tem primeru gre za premik pozicije določenega 

objekta. To lahko razberemo na desni strani, kjer piše »Position«. Za vklop »keyframinga« se 

najprej na časovnici postavimo tja, kjer želimo, da se animacija začne in nastavimo začetne 

parametre nastavitve, ki jo želimo animirati. Ko imamo to izbrano, je potrebno klikniti na 

ikono v obliki štoparice in s tem se pojavi začetni »key frame«. Nato na časovnici izberemo, 

kje se bo animacija končala in določimo nove parametre. Ko spremenimo parametre, program 

že zazna, da smo vključili »keyframing« in nam avtomatično na časovnico postavi novo 

točko.  

 

Slika 7: Keyframe 

Vir: Lasten 

http://en.wikipedia.org/wiki/Animation
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5.1.2  Nastavljivi parametri 

V programu After Effects ima večina nastavljivih parametrov možnost animacije. Ta zajema 

vse od osnovnih parametrov, kot so pozicija, velikost, prosojnost in rotacija, ter vse do 

kompleksnejših nastavitev, ki so integrirane v specifične efekte.  

 

Za svojo animacijo sem predvsem uporabljal osnovne parametre, saj je v večini šlo za 

spremembo pozicije elementov ali spremembo velikosti. Pri spremembi pozicije sem 

elemente  postavil izven vidnega polja in jim nato določil, kdaj in kako se pojavijo na ekranu. 

Pri spremembi velikosti pa je  element že postavljen na končno pozicijo, vendar ima začetno 

vrednost 0, šele ko se izvede animacija, se element poveča in postane viden. 

 

Slika: 8 Pomik 

Vir: Lasten 

Na sliki so združene štiri sekvence, ki s puščicami ponazarjajo, kako se tekst pomika iz 

nevidnega polja proti svoji končni poziciji. 

 

5.1.3  Anchor Point / Sidro 

»Anchor Point« ali sidro je točka, ki jo ima vsak element. Za to točko bi lahko rekli, da je 

težišče elementa, ki pa ga lahko spreminjamo.  

Pri moji animaciji je bilo to najbolj pomembno zaradi rotacijskih premikov. Ker sem želel 

tekst animirati na čim več različnih načinov, nisem spreminjal samo pozicije, ampak tudi 
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rotacijo. To mi je omogočilo da se tekst, ki je bil izven vidnega polja, ni nujno pripeljal po 

ravni liniji, ampak v loku. Za to sem moral spremeniti pozicijo sidra. 

 

 

Slika 9: Sidro 

Vir: Lasten 

Slika ponazarja sekvence vrtenja glede na pozicijo sidra. Rdeči piki predstavljata sidro 

vsakega besedila. Levo besedilo ima sidro v centru, desno besedilo pa ima sidro izven svojega 

geometrijskega centra. 

 

5.1.4  Motion Blur / Zabrisano gibanje 

Nekatere animacije same po sebi lahko izpadejo zelo nerealne in toge, da bi se temu izognil, 

sem uporabil nastavitev »Motion Blur«. Ta nastavitev se nahaja tam, kjer lahko elemente 

spremenimo v 3D objekte (glej Slika 6). Na skrajno levi strani se nahaja ikona s tremi krogi. S 

klikom na prazen kvadrat določenemu elementu omogočimo »motion blur«. Ta nastavitev 

omogoči, da so elementi, medtem ko so v gibanju, zamegljeni. Gre za preprost efekt, ki pa 

lahko naredi celotno animacijo veliko boljšo. 
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5.2 Expressions / Izrazi 

V prejšnjih podpoglavjih sem zajel osnove animacije s premikanjem elementov, to poglavje 

pa je namenjeno izrazom. Gre za programski jezik, ki je integriran v sam program After 

Effects in nam omogoča programiranje animacije. Gre za eno bolj zapletenih metod animacije 

v programu, vendar pa omogoča tudi nekaj preprostejših in uporabnih izrazov. To naredimo, 

da pritisnemo Alt in kliknemo štoparico (glej Slika 7) pri izbranem elementu in parametru, ki 

mu želimo dodati izraz. Ko to naredimo, se nam na časovnici pojavi novo okno, v katerega 

lahko pišemo izraze.  

 

Nekateri elementi v moji animaciji so konstantno v gibanju. To sem naredil zato, ker izboljša 

dinamiko celotne animacije. Če bi to želel doseči z osnovno metodo animacije, bi mi to lahko 

vzelo več ur časa, zato sem uporabil izraz »wiggle«. »To je izraz, ki se uporablja za naključno 

spreminjanje izbranih parametrov.« (http://helpx.adobe.com/en/after-effects/using/expression-

language-reference.html) Jaz sem izraz uporabil za spreminjanje pozicije, njegov končni efekt 

je bil tresenje. Primer »wiggle« izraza, ki sem ga uporabil, zgleda takole: wiggle(5,20). 

Beseda »wiggle« programu sporoči, kateri izraz uporabljamo, v oklepajih pa so parametri, ki 

vplivajo na animacijo. Prva številka predstavlja vrednost, za koliko naj se največ spreminja 

vrednost originalne nastavitve parametra. Druga številka pa predstavlja vrednost, na koliko 

časa naj se izvede ukaz prve številke.  

 

5.3 Efekti 

Nabor efektov, ki nam jih omogoča program, je zelo velik. Poleg tega lahko efekte ustvarjamo 

tudi sami ali pa jih prenesemo iz spleta in uvozimo v program. V tem poglavju bom predstavil 

efekte, ki sem jih uporabil za izdelavo svoje animacije, in njihovo delovanje. 

 

5.3.1  Fast Blur / Hitri zabris 

Če dobesedno prevedemo ime efekta, bi se mu lahko reklo hitri zabris. In kot že samo ime 

pove - s tem efektom lahko naredimo zameglitev elementov ali  celotne kompozicije. Gre za 

http://helpx.adobe.com/en/after-effects/using/expression-language-reference.html
http://helpx.adobe.com/en/after-effects/using/expression-language-reference.html
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statičen efekt, pri katerem nastavimo intenzivnost zamegljenosti, ki pa jo je kasneje mogoče 

spreminjati s pomočjo »keyframinga«. 

Ta efekt sem uporabil bolj kot trik, ki simulira globinsko ostrino. Globinska ostrina je termin, 

ki se predvsem pojavlja v fotografiji in filmski produkciji, in določa, na kateri točki bo slika 

najbolj izostrena. Najbolj se to opazi pri detajlnih fotografijah, kjer je detajl izostren, okolica 

pa zamegljena, saj želimo, da je opazovalec osredotočen na določen detajl. 

 

Da sem dosegel le delno zameglitev celotne slike, sem uporabil metodo maskiranja. Masko se 

lahko naredi z »Mask/Shape Tool« orodjem ali s »Pen Tool« orodjem. Izbira je odvisna od 

tega, kakšno obliko maske želimo imeti. Z masko lahko zakrijemo določen del kompozicije 

ali pa določenemu delu spreminjamo videz, ne da bi s tem spreminjali nastavitve elementov.  

 
Slika 10: Maska 

Vir: Lasten 

Rumena elipsa na sliki predstavlja obliko maske. Maski sem dodal efekt »Fast Blur« in 

določil, da efekt vpliva na vse izven elipse. Da prehod med masko in kompozicijo ne bi bil 

tako oster, sem vključil nastavitev »Feather«. Ta nastavitev omogoča, da naredimo prehod 

med masko in kompozicijo odrezan ali prelivajoč. 

 

Opcijo globinske ostrine nam omogoča tudi simulacija kamere v After Effects, vendar je za to 

potrebno imeti objekte različno oddaljene v Z prostoru. Vsi moji objekti  so postavljeni v isti 

ravnini, zato ta efekt s kamero v mojem primeru ne bi deloval.  
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5.3.2  Drop Shadow / Padajoča senca 

To je efekt, s katerim se da ustvariti umetno senco objektov. Sence v After Effects se da 

narediti na več načinov. Eden od načinov je, da naredimo plast, na kateri se nahaja umetna 

luč, in objektom določimo njihov odziv na svetlobo. Ta svetloba lahko vpliva tudi na barve in 

svetlost celotne kompozicije, zato v mojem primeru ta metoda ni bila primerna. Poleg tega so 

sence narejene z lučjo pogojene z oddaljenostjo objektov v Z prostoru in odvisne od pozicije 

luči. 

 

Ta efekt sem uporabil pri galeriji slik, ker s tem animacija izpade bolj živa in daje gledalcu 

občutek gledanja pravih fotografij. Da mi efekta ni bilo potrebno vstavljati na vsak objekt 

posebej, sem ga vstavil v izvoženo animacijo celotne galerije in ga pripel na video. S tem sem 

prihranil nekaj časa in posledično je bilo potrebno samo enkrat nastaviti parametre efekta. 

 

5.3.3  Stroke / Zamah 

Efekt »Stroke« sem uporabil za animacijo črt, ki povezujejo različne prosojnice med seboj. Za 

uporabo tega efekta je bilo najprej potrebno narisati črte, ki povezujejo prosojnice med seboj. 

To sem naredil z orodjem »Pen Tool«. Ker efekt deluje na razkrivanju oziroma zakrivanju 

maske, sem s »Pen Tool« orodjem preko vsake črte narisal še eno črto, ki je predstavljala 

masko. Ko ima črta določeno masko, ji lahko dodamo efekt. Ker so nastavitve tega efekta 

težje, jih bom pojasnil s pomočjo slike. 

 

Slika 11: Stroke efekt 

Vir: Lasten 
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Ko dodamo efekt črti, se na levi strani pojavijo nastavljivi parametri za efekt. Pri izbiri »Path« 

moramo izbrati nastavitev Mask 1. S tem izberemo masko, ki smo jo narisali preko črte in 

preko katere se bo črta razkrivala. Naslednja nastavitev, na katero moramo biti pozorni, je 

»Brush Size«. Ta mora biti velika vsaj toliko, kolikor je debelina naše originalne črte, saj bi v 

nasprotnem primeru črta izpadla tanjša. Pri nastavitvi »Pain Style« je potrebno izbrati »Reveal 

Original Image«, kar pomeni, da se nam bo pri animaciji razkrivala originalna slika. V mojem 

primeru črta. Nato pa je potrebno nastaviti še »Start« in »End«. Na začetku morata biti obe 

nastavitvi na 0%. Nato na časovnici določimo, kje se bo črta začela razkrivati in tam naredimo 

»keyframe«. Potem se na časovnici pomaknemo naprej, kjer želimo, da je črta razkrita, in tam 

za nastavitev »End« izberemo 100%.  

 

5.3.4  Change to Color / Spremeni v barvo 

Efekt »Change to Color« omogoča spreminjanje ene barve v drugo. Gre za zelo močan efekt, 

saj z njim lahko spreminjamo tudi barve v video posnetkih, kot so na primer barve oblačil, 

ozadje, barve objektov idr.  

 

Vse prosojnice, z izjemo galerije, imajo določene elemente v vijolični barvi. Ko sem imel 

animacijo že skoraj dokončano, se je izkazalo, da naročniku ta barva ne odgovarja, tako kot 

mu je na začetku. Zato sem moral barvo spremeniti. Vse prosojnice so bile že izvožene kot 

video in pozicionirane v kompozicijsko okno. Če bi želel ročno spremeniti barvo, bi moral to 

storiti za vsako prosojnico posebej, ponovno izvoziti in ponovno vse pozicionirati. To bi bilo 

zelo zamudno, zato sem uporabil efekt »Change to Color«, ki sem ga pripel na Adjustment 

layer. Adjustment layer je plast, ki je namenjena predvsem dodajanju tako imenovanih CC 

(Color Correction) efektov oziroma barvni korekciji, ne da bi s tem morali spreminjati 

original.  

 

Potrebno je biti pozoren, ker ta efekt lahko spremeni barvo tudi elementom, za katere si tega 

ne želimo. Temu se lahko izognemo tako, da plast, katere ne želimo spremeniti, pomaknemo 

nad plast z barvnimi korekcijami, kot sem to naredil z galerijo. V primeru, da se na plasti 
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nahaja objekt, ki ga želimo spremeniti, in objekt, ki ga ne želimo spremeniti, lahko stvar 

korigiramo z uporabo mask.  

 

Slika 12: Spremeni bravo 

Vir: Lasten 

Na levi strani ni dodanega efekta, na desni strani pa je dodan efekt »Change to Color«. 
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6 KAMERA 

 

Za prehode med prosojnicami sem se odločil uporabiti orodje Kamera (Camera). Kamero 

program dojema kot plast, zato jo najdemo pod zavihkom Layer > New > Camera. Kot sem že 

omenil v predhodnem poglavju (glej 4.5 3D prostor), morajo biti objekti nastavljeni kot 3D 

objekti, saj kamera deluje na principu simuliranega 3D prostora. V stroki se temu prostoru 

večkrat reče 2.5D, saj ne gre za pravi 3D, ampak za simulacijo le tega.  

 

Prehode bi bilo mogoče narediti tudi s premiki prosojnic, vendar je takšen način bolj zamuden 

in tudi bolj neroden. Tudi dinamika animacije ne bi bila tako dobra, ker bi se s tem omejili na 

statično ozadje. Zato sem že v naprej izvožene prosojnice pomanjšal, da je bila vsaka 

približno enake velikosti, in vsako posebej postavil v kompozicijsko okno, kot je prikazano na 

sliki. 

 

Slika 13: Postavitev prosojnic 

Vir: Lasten 

Ko sem imel vse objekte postavljene, sem z nastavitvami za kamero usmeril fokus na prvo 

prosojnico. To sem naredil s spremembo pozicije kamere in s približevanjem.  
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6.1 Gibanje kamere 

Gibanje kamere je mogoče nadzorovati na dva načina. Kamero lahko pomikamo s 

konstantnim spreminjanjem pozicije in s pomočjo »keyframeinga«. Ta metoda je lahko zelo 

nepraktična, saj konstantno spreminjamo nastavitve kamere, kar lahko kasneje privede do 

težav. 

 

Druga metoda pa je z uporabo »Null Object«. Gre za posebno vrsto objekta, ki ga dodamo s 

klikom na zavihek Layer > New > Null Object. Ta se nam nato pojavi na časovnici kot nova 

plast. To je neviden objekt, ki se predvsem uporablja pri sledenju kamere ali sledenju gibanja 

(Motion Tracking).  

 

Za sledenje kameri je »null« objekt potrebno postaviti na sredino kompozicije, nato pa s 

pomočjo »keyframe-ov« objekt animirati, da se giba po liniji, kateri želimo slediti s kamero. 

Nato je potrebno kamero povezati z »null« objektom, da sledi gibanju le tega. To sem naredil 

z nastavitvijo »Parent«.  Na seznamu plasti se na desni strani nahaja zavihek »Parent«, dokaj 

primeren prevod bi bil »vodnik«. Če odpremo ta zavihek, se nam pokaže seznam ostalih 

plasti, pri čemer lahko določimo starševsko - vodnikovo plast za plast, na kateri se nahajamo. 

Plasti, ki ji določimo vodnika, lahko rečemo tudi otrok. Če objektu določimo vodnika, 

pomeni, da bodo vse spremembe gibanja ali oblike vodnika enako vplivale na otroka. Iz slike 

je razvidno, da sem kameri kot vodnika določil objekt Null 2, kar pomeni, da bo kamera 

sledila gibanju Null 2 objekta. 

 

Slika 14: Vodnik 

Vir: Lasten 
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7 IZVAŽANJE VIDEA 

 

Ko je animacija končana, je video potrebno izvoziti iz programa. After Effects ponuja veliko 

različnih video formatov za izvažanje in sam sem potreboval kar nekaj časa, preden sem 

odkril kodek, ki ima najboljše razmerje med kvaliteto in velikostjo končne datoteke.  

 

Za izvoz končne animacije je potrebno odpreti zavihek Composition > Add to Render Queue. 

Nato se tam, kjer se je prej nahajala časovnica, pojavijo nastavitve za izvožen video. 

Spreminjamo lahko »Render Settings«, »Output Module« ter »Output to«. Od teh nastavitev 

je najpomembnejši »Output Module«, s katerim se nastavi video format.  S klikom na to 

nastavitev se odpre novo okno. 

 

Slika 15: Meni za izvoz videa 

Vir: Lasten 
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V mojem primeru sem izbral format QuickTime, nato pa sem kliknil na gumb »Format 

Options« in v zavihku, ki se pojavi v novem oknu, izbral H.264. V primeru, da ima animacija 

tudi zvoke, je potrebno obkljukati »Audi Output« in nato pritisniti OK. S klikom na nastavite 

»Output« nato izberemo, kam želimo datoteko shraniti. Vseh ostalih nastavitev ni potrebno 

spreminjati. Nato pritisnemo gumb »Render« in počakamo, da program izvozi projekt. 
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8 ZAKLJUČEK 

 

Med izdelavo diplomske naloge in animacije sem spoznal, kako močno orodje je Adobe After 

Effects. Odkril sem veliko novih orodji in trikov, ki lahko olajšajo delo in izboljšajo 

produktivnost. Kljub temu pa se mi zdi, da je končni izdelek le delček vsega, kar premore 

program. 

 

Namen naloge je bil ugotoviti, ali je mogoče ustvariti grafično animacijo samo z uporabo 

orodji, ki nam jih ponuja program After Effects. Kljub temu, da bi temu lahko odgovoril 

pritrdilno, pa se mi zdi, da so orodja za izdelavo grafičnih vsebin v tem programu zelo šibka. 

Vendar bolj kot šibkost orodji za izdelavo grafik me preseneča, da bi vseeno bilo mogoče 

celotno animacijo izdelati samo s pomočjo programa After Effects. Potrebno se je zavedati, da 

je program v svojem bistvu namenjen animaciji in izdelavi efektov, zato je možnost izdelave 

grafik samo še ena od prednosti programa. Seveda pa nam pomoč programov, kot so Adobe 

Photoshop in Adobe Illustrator, bistveno olajša delo, saj oba vsebujeta bolj napredna grafična 

orodja in njun primarni namen je izdelava grafik. S pomočjo drugih programov si lahko delo 

skrajšamo tudi za nekaj dni. Vendar to ne izključuje dejstva, da nam Adobe After Effects 

omogoča grafično obdelavo kakor tudi izdelavo animacije. Medtem ko nam druga dva 

programa omogočata boljšo in lažjo grafično obdelavo, ne pa tudi animacije.  

 

Ugotavljam, da je Adobe After Effects najbrž eno najmočnejših orodij namenjeno izdelavi 

animacij in efektov. Z malo spretnosti in iznajdljivosti pa je lahko tudi še nekaj več kot to. 
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10 PRILOGA 
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